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This hands-on lab will demonstrate a reverse-engineering workflow that uses ReCap 360 software to
move a real-life object into the Fusion 360 3D CAD design app, moving items from the ground to the
cloud. In the Fusion 360 app, attendees will discover how to use OBJ files produced from
photogrammetry to create powerful designs in the Fusion 360 app.

Learning Objectives
At the end of this class, you will be able to:

=  Convert photos to 3D Mesh Models using Recap 360

» Master Modeling and Sculpting techniques in Fusion 360
= Utilize Mesh Models to improve designs in Fusion 360

» Create quality visualizations of designs in Fusion 360

About the Speaker

Nathan is a Frontline Product Support Specialist in the Global Customer Service Organization at
Autodesk. He received his Bachelor of Science in Mechanical Engineering from the University of
Texas at Arlington and has spent 3 years in Design Engineering in the Automotive Alternative
Fuels industry designing high pressure gaseous fuel systems. He has over 8 years of
experience supporting Mechanical CAD software and bringing smiles to customer’s faces. He is
a class instructor at the Portland makerspace, ADX and it a total CAD nerd.

Nathan.Chandler@Autodesk.com
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Introduction

Have you ever been tasked to design something and wondered what the right length, angle, or curvature
should be? Ever wish you could import the world into your CAD software? With Recap 360, all you have
to do is take a picture! Using Recap 360 can help you find that ethereal, elusive measurement without the
need for a notepad, pencil, measuring tape, caliper, micrometer, or a protractor. Recap 360 is a cloud
based service that enables you to generate mesh models from photo using photogrammetry, the science
of making measurements from photographs.

This guide is intended to provide you with the tools you need to get started with photogrammetry in a
flash. Using a mesh model generated from photos via Recap 360, this class will demonstrate how to
leverage this measurement data to perfect a design in Fusion 360. Fusion 360 has built in tools to help
you leverage your mesh model, making Fusion 360 and Recap 360 a perfect fit.

About Recap 360

Recap 360 is a cloud service available with monthly, quarterly, or annual subscription. Recap 360 is
similar to 123D Catch, but designed for professionals to produce full resolution mesh or point cloud data.
An annual Autodesk ReCap 360 license includes 50 cloud credits and 25G of cloud storage. With
subscription you can process up to 250 photos in a project. Each project consumes 5 cloud credits. Draft
resolution projects are free, but have a limit of 50 images at 12 MP in size. Recap 360 generates OBJ,
RCM, FBX, RCS, and IPM filed that will work with numerous products.

Recap 360 Community

About Meshmixer

Meshmixer is an experimental 3D modeling tool developed by Ryan Schmidt, a computer graphics
researcher at Autodesk Research. Meshmixer is a free tool for making crazy 3D stuff without too much
hassle. Or boring stuff too. You decide.

Meshmixer

About Fusion 360

Fusion 360 is the first cloud based 3D CAD/CAM tool for collaborative product development. With a
rapidly expanding portfolio of capabilities that currently includes parametric design, direct modeling, and
free form tools, Fusion 360 gives you the freedom to design differently. Fusion 360 is supported on the
Mac or Windows operating system and is tailored for Industrial and Mechanical designers. Free for
students, educators, and startups or available with monthly, quarterly, or annual subscription.

Fusion 360 Hub


http://forums.autodesk.com/t5/photo-on-recap360/bd-p/3019
http://www.meshmixer.com/index.html
http://fusion360.autodesk.com/about
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Convert photos to 3D Mesh Models using Recap 360

To get started, you'll need to take some photos. Before you point and shoot, let’s take a look at how
Recap 360 works. Photogrammetry take advantage of parallax, the displacement in the apparent position
of an object viewed along two different lines of sight.

Viewpoint A )

® Object el
Viewpoint B

Distant background

Viewpoint A Viewpoint B

L] ]

Figure 1 Photogrammetry Utilizes Parallax to generate measurements of an object

Mapping pixels and features between the photos, Recap 360 uses algorithms and cloud based computing
to stitch overlapping images together, generating 3D models. There are some specific requirement for the
types of pictures that result in a successful project. Let’s review some basic tips that will help insure that

your projects generate successfully.
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Tips for photos

Recap will calculate the position of the camera for each image. Avoid using zoom if you are not
using a fixed lens. Allow for overlap in the photos for better reconstruction. Move around the
target in 5-15 degree increments and try to take photos from a couple of different heights. Keep
the target in focus and take lots of photos!

il

Figure 2 Fusion 360 calculates the camera position for each photo
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Figure 3 Recommended positions for capturing a target

Below is a sample of some photos of a failed project in Recap 360. The below images were downloaded
from a website. Without a background and the effects of real lighting in these photos, Recap 360 was not
able to generate a model. Avoid having a monochromatic background.

19PNG
Figure 4 Example of poor images for Recap 360
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You will want high resolution photos that are crisp and clear in both the foreground and background. The
best way to accomplish clarity in your photos is to use a slower shutter speed. With slower shutter
speeds, slight shaking will blur the photos. Try using a tripod to steady your hand.

It is important to match up the colors and pixels between photos. In the below sample of photos which did
generate a successful model (but not great results), the intro level Nikon had white balanced set to
Automatic. You can see how this setting impacts the colors in the photos. In this case shooting in Auto-
Mode is not recommended. It will help to be familiar with the settings of your camera since they may vary
by make and model.

IMG_1523.JPG IMG_1524.JPG IMG_1525.JPG

IMG_1526.JPG IMG_1527.JPG IMG_1528.JPG

Figure 5 Watch for Automatic Settings in your Camera

Shoot RAW instead of in a compressed format. File compression like JPEG formats will produce smaller
files sizes, but will reduce image quality. Another good tip is to create reference points in the images that
can be used to manually stitch photos together. In the photos from figure 5, you'll note that | marked
paper with colored dots. In the below images in Figure 6, | used some sticky notes to create some extra
reference points. In the event that Recap 360 is unable to use some of the image, there are tools
available to manually stitch photos. Review the section on manually stitching photos in Recap 360 for
further detail.
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_359.JPG _360.JPG _361JPG
Figure 6 Try creating some reference points in the event that you have to stitch photos manually anything will work
like sticky notes @

Photography is a dynamic job. The surroundings, lighting, and the subject matter change. What may work
in one scenario, may not work in another. The best thing to do is get out there and try. Having experience
with your camera and being familiar with the settings will go a long way when shooting.

For this class | have included a data set of 250 photos, courtesy of The Good Mod in Portland, OR. The
photos are of Reclining Lounge Chair 164 designed by Arne Vodder and manufactured in the 1960’s. This
beautiful chair will serve as the center piece for this class. Using these photos, we will generate a model
with Recap 360, clean-up our mesh model in Meshmixer, and then bring this mesh into Fusion 360 to
utilize the reality capture data for some digital restoration.

_670JPG _671.JPG

_672JPG _673.JPG _674.JPG
Figure 7 Images of Reclining Lounge Chair 164
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Getting the photos into Recap 360

If you've shot in RAW format, you may need to first convert the photos to a JPEG or JPG format. These
are the only formats that are currently supported for Recap 360. In my case, my Nikon created NEF
(RAW) files. | was able to convert into JPEG format using a free program called View NX 2. Utilize highest
quality settings during the conversion process to reduce any impact to image quality.

15 ViewNX 2 - D:\Data\Recap The Good Mod Chair - Upholestry\RAW
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Figure 8 Using View NX 2 to conv
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Submitting a Project
Getting the photos into Recap 360 is a snap.

Go to https://recap360.autodesk.com/

Sign in with your Autodesk ID

Select a new photo project.

Enter a project name

Initially, | recommend using the preview mode with no other options. This mode will not produce

as high of a resolution mesh, but will finish faster. This will give you a good idea of how your

photos are doing.

6. Upload your photos. You can drag and drop or browse and select photos. Note that for a recap
pro project the upper limit is 250 photos.

7. Submit the project and wait

8. You will receive an e-mail notification when the project is finished processing. You may check the

home page in Recap 360 to periodically review the progress of the project.

ahrwbhpE

enter a project name

choose your project options

preview ultra

O use smart cropping 0o

choose export formats

O rcm

Figure 9 Upload photos to Recap 360. For the initial submission, try running the project in preview mode.

9. Once complete, select the project to preview the results in a web browser. If the results are
acceptable and there are not too many unstitched photos, submit the project again in Ultra Mode.

10. When the project is done processing, you may log into Recap 360 and then download results
from the home window.

recent projects

share scans to the cloud examples

learn more about
ReCap Pro

7.
Good Mod -Secon
2days ago

Good Mod Chai...
12 days ago
open a—.

\
|

A
(14
" § Good Mod Chai...

12 days ago

» project gallery . “A

Figure 10 Download the results from Recap 360

10
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Preview vs. Ultra

The figures below compare the difference between resulting mesh files submitted by using Preview and
Ultra modes in Recap 360. The first figure is the mesh model generated by Preview mode and the second
image by Ultra mode. Even in these small screenshots, it is easy to discern the difference in surface
quality and mesh density form the results.

A

Figure 11 Image of esh Generated in Preview mode in Recap 360 (183774 Triangles, 91992 Vertices)

Figure 12 Image of Mesh Generated with Ultra Mode in Recap 360 (1660613 Triangles 830684 Vertices)

At this point, you may be wondering why not submit the project in Ultra mode all the time? Some photos
may fail to stitch or you may find the results are not even close to what you want. Before committing to an
Ultra project, which will take longer to process and costs money, do a preview to see if you're getting
close.

The time difference between preview and ultra will differ between projects, but my experience has been
around 10 X. If an Ultra project takes 10 hours to process, the preview will take around 60 minutes to
generate. Why invest additional hours only to uncover problems and then have to re-submit? Be Efficient!
Using Preview mode will give you an opportunity to re-take photos or manually stitch images to improve
your results.

Please keep in mind that the model may result with a few anomalies, especially in a preview mode. The
perfect mesh may not come easy, especially for complex objects or if this is your first time through this
process. As your skills develop taking pictures and you learn the ropes, the reality data produce from this
process will improve.

11



Take a picture, it will last longer: Design in Fusion 360 with help from Recap 360

Manually stitching photos in Recap 360

If your photos fail to stitch, there is an option to manually stitch images. Let’s take a closer look at how
that works. When a project is completed or if it fails, you will receive an e-mail notification to let you know
that the project is complete. Once you get this, go to the Recap 360 website and log in. Select your

project to open it. In the browser on the left side of the project, scroll to the bottom to look for unstitched
photos.

Figure 13 Unstitched Photos in a Project

Select the photo that you would like to stitch manually. The preview window will snap to that image and
you will be provided the option to exclude or stitch an image. Select Stitch to proceed with the manual
stitch process. If you would prefer to exclude the image, you can select exclude and the photo will be
removed from the project. If you choose this option, you can then upload a new photo to the project.

Figure 14 select the unstitched photo to begin the manual stitching process

12
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In the next screen after selecting Stitch, the unstitched photo will appear in a panel on the left while the
photos that were stitched appear in the right. You will need to select a stitched photo from the panel to
proceed forward. Try to select a photo that will share many common reference points with the unstitched
photo on the left panel.

Figure 15 select a stitched photo containing common features

The next step is to select a target reference point in the unstitched photos. Note that you can use the
scroll wheel on your mouse to zoom in and out for a more precise selection. Select the same target point
in the stitched photo on the right.

== |

«_700JPG »

Figure 16 select a target reference point in both stitched and unstitched photos

Repeat this steps and select multiple points between the photos. Try to spread the points out as much as
possible around the scene. The more points you select the more precise the manual stitch will be.

13
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Figure 17 select multiple targets for improved results

The next step is to change to a different, successfully stitched photo in the right panel.

«_700JPG »

Figure 18 select other stitched photos to match targets with

Select the target reference point in the unstitched photo that you would like to match in the stitch photo on
the right. The target point will become bold and the progress meter will show on this target.

Next, select the target point in the stitched photo on the right side. You'll note as this task is completed
the target point will turn from red to yellow to green. Each target reference point should be tagged in 3 or
more stitched photos. Using more photos in the stitch command will result in higher accuracy. It is easy to
see now why the colored dots from figure 5 or the sticky note pieces in figure 6 might be helpful.

14
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«_7110PG »

==y !l

[LITFas

Figure 19 select target point in other photos until target is shown with a full green circle

Once this process is completed for each photo that you would like to manually stitch, select Save located
in the upper right hand side of the screen. To see the impact the manually stitch will have on the model,
the project will have to be re-submitted. Stick to the Preview Mode until you're satisfied with the results.

Warning about manual stitching

I've found that if Recap 360 is not able to automatically stitch the photos, the photos are generally flawed
or there is not enough overlap in the photos that I've taken. Unstitched photos are a good way to get
feedback on the quality of photos that were taken for a project. Most of the time, you’ll find that an
unstitched photo is a little blurry or sub-optimal. You may be able to manually stitch a few photos and get
improved mesh data. However, also consider starting from scratch and take more or improved photos.
You may consider staying within a focused area of the target. For the mesh.obj file utilized during this
class, no manual stitching was performed.

Downloading OBJ file from Recap 360

When you are satisfied with the previewed results, you may download the obj file from the home page in
Recap 360. Look for the download cloud icon to select the OBJ file. This will download the full resolution
file. For this class, the mesh.obj file included in the class materials are my results.

share scans to the cloud examples

recent projects

learn more about
ReCap Pro

create 3D from photos

Figure 20 Downloading result from Recap 360

15
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Refining your mesh for Fusion 360 in Meshmixer

Once you’ve generated a model, the next step is to process the mesh and prep it for use in Fusion 360.
You will need to prep the mesh for a few reasons.
e Fusion 360 currently has some current (Nov. 2014) limitations with the size of the mesh that is
possible to utilize without performance suffering.
e Recap 360 may have stitched together part of the scene that is unnecessary.
¢ The mesh may be more dense than required.
e There may also be some model anomalies that that need to be corrected.

To process the mesh file, we will import the resulting .obj file from Recap 360 into Meshmixer. With
Meshmixer, it is possible to modify the resulting OBJ file to something more useful for Fusion 360. You
can download Meshmixer for free for Windows or Mac OS. Please note that this section of the guide was
writing for the Windows OS. Some shortcut keys may vary for Mac OS. Refer to the keyboard shortcuts in
Meshmixer for more info.

As you go through this process, it may help to save the progress stored in separate files. Creating several
Meshmixer (*.MIX) files will allow you to come back if you'd like to test some different options.

Import the OBJ File from Recap 360

1. Launch Meshmixer

2. Select Import

3. Browse to and select the Mesh.obj file downloaded from the Recap 360 Project

4. Refine the mesh using tools in Meshmixer. The following sections will detail the tools you may
use to do this.

Figure 21 blank new workspace in Meshmixer

From the View drop down menu, you may toggle the visibility of the mesh or use the keyboard shortcut,

“W.” In the lower right hand corner there is a counter that counts the number triangles and vertices in the
Mesh. Our purpose will be to reduce the count of vertices and triangles to a manageable size for Fusion

360.

Figure 22 Element counter in Meshmixer

16
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Crop the Mesh

The first step is to remove any unwanted mesh by cropping out unwanted elements.

Using the Plane Cut command located on the Edit Panel, you can quickly remove the floor that has been
capture in the model.

) Autodesk Meshmixer - mesh2.0bj -

-

File Actions View Help Feedback

[l Piane cut

Type Cut v

Fill DelRefine ¥

Hard Edge

Figure 23 use Plane Cut command to quickly eliminate unnecessary mesh elements

Don’t worry about small bits of the floor left over. You can use the select tool to quickly select and delete
the unwanted elements with the delete key on your keyboard. There are several different types of

selection methods available. Free hand lasso, a laser, selection brush, line-loop etc. These tools should
be fairly straight forward to use.

For brush selection, you may increase or decrease the size of the brush by using the “[* or “]” keys on the
keyboard. You may also invert the selection at any time by selecting the “i” key. If you'd like to learn more
about selection in Meshmixer, refer the following Meshmixer webpage.

17
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The next step will be to create a series of straight lines to select and remove the mesh in the middle of the
seat. Once the correct area has been selected, press the delete key to remove it.

. ! &

11

Ly

Figure 24 select the center of the seat for selection and delete

After deleting elements, there will be holes in the model that need to be repaired or healed. There is an
automated tool, the Inspector command located in the Analysis panel. The inspector tool will highlight the
holes in the model in the work space. Select Auto Repair All with the flat fill option to close any holes in
the mesh body.

-
r Q Inspector
@, Inspector
P, —8 99 units/scale
. v
*Sm,p y Measure [Dimension FlatFl
Small Thresh 0.01

om  Stability

E Strength

h Overhangs

% Slicing

RY

Analysis

D

Figure 25 Use the Inspector tool to repair "holes" in the model

18
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Smooth the Model

Using Bubble Smooth, you can help smooth out surface deviations by adding mesh “material” to the
model. The brush setting will modify how the brush interacts with your model. Experiment with these
settings to fine tune the effects of the brush has on the model to match your preferences. A key setting is
the Strength of the bubble smooth. Keep in mind that you can quickly change the size of the brush with
the “[“ or “]” keys on the keyboard. To use the tool, simply click and drag your cursor over the model.

_/ Properties 5 a Dwrag Draw Drawl Flatten
R
Select
Strength 4
< A
' Size 16 Inflate v -
Sculpt

I /_\
'K Depth 1]
4 s

Zeny - PaintV e
Lazyness a 'l y
a ¢
&
Symmetry
Edt | Flaw RobustSmooth

Figure 26 Use the Bubble Smooth with the correct properties to correct surface deviations

Properties & a

Strength

Depth (]

——

Lazyness 0

[~ S—
Symmetry

< Flow

¥ Volumetric

SymSnap

Refinement & a

Figure 27 Note the deviations in the back rest of the chair

Figure 8 Image after using Bubble Smooth

There is another regional smoothing command located in the Deform fly-out menu of the Edit panel. The
workflow is simple, select the region you would like to smooth and press the CTRL + F key. You can
smooth a localized region or you can globally smooth the entire model, by pressing selecting CTRL + A to
select all and then CTRL +F to initiate the smooth command. Please keep in mind that the more elements

19
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selected, the more processing it will take to perform the operation. Be patient when smoothing a large

model!

Similar to Bubble smooth, this smooth operation has several parameters that will affect the output.

As Scale is reduced, the smoothing becomes more localized, while a larger scale results in

Scale

Scale .
more global smoothing.
Smooth Reducing Smooth in the range from 1 to 0 will adjust the amount of smoothing, towards the
original shape. Lowering Smooth below O will exaggerate the shape.
Cotan smoothing algorithm produces the smootheest results. One drawback of Cotan
Type smoothing is that if you have ugly polygons before you smooth, you will have ugly
polygons afterwards. Uniform smoothing spreads out the vertices more evenly.
Smoother =*
Type Cotan o
Smooth 1.0000 =
Scale 110000 =
Figure 29 Image of a preview model before Smoothing
Smoother #*
Type Cotan v
Smooth 1.0000 =

10,0000

“nr

Figure 30 Image of a preview model after Smoothing

20
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This is a critical step for preparing the mesh model for action in Fusion 360 since you can drastically
reduce the size of the mesh. The goal should be to reduce the mesh, but not reduce the geometry you

are utilizing.
1.
2.

3.

In a similar fashion to the smooth command you can impact a localized area by selecting a small
area with the select brush or select the entire model by selecting CTRL + A.

Next, initiate the reduce command by selecting Reduce from the Edit fly-out menu or by selecting
SHIFT + R.

Select Accept when satisfied with the results.

Also like the smooth command, the reduce command may take some heavy resources to process, so be
patient with the command. One tip is to select the Reduce slider and then use the left and right arrow
keys to adjust the percentage. In this example, you may reduce the model by as much as 75%.

File Actions View Help Feedback

Edit... L4

T Convert To... 3

- Deform... >
L)

Meshmix Modify... L
'/ Select # 4
Select

Unwrap Brush v
Size 55
Sculpt
L — —
!_” Symmetry
=
Fitrers -
3 Crease Angle 0
Edit o
@ Allow Back Faces
.
Fle | Actions View Help Feedback
Reduce #*
Import Reduce 75 %
@ —
L + Preserve Boundaries
Meshmix | Adaptive
/|| =1

Figure 31 before and after using Reduce
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Remesh the Model

Remeshing the model can make the Mesh more uniform. This tool works just like the smooth tool above
and can also help reduce the number of elements in the mesh.

1. You can impact a localized area by selecting a small area with the select brush or select the
entire model by selecting CTRL + A.

2. Next, initiate the Remesh command by selecting Remesh from the Edit fly-out menu or by
selecting the “R” key

3. Select Accept when satisfied with the results.
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Figure 33 Model after remesh command

Reposition and Resize the model (optional)

Note that model can always be repositioned and resized in Fusion 360, so this step is not critical. I've
included this for flexibility in your workflow.

Rotate the model:
1. Use CTRL + Ato select all.
2. Initiate the Edit > Deform > Transform command
3. Select the green rotation glyph and rotate the model approximately 16.7 degrees
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Fie Actions View Help Feedback

e Q% QI 0|

i

Transform

Harden

Figure 34 Use transform to rotate model

Resize the Model:

aghrwNPE

From the Action drop down menu select > Select Configure Units

Select Inch in the Units drop down box.

Select Convert in the subsequent dialog

Type in 30 for the units in the X direction.

This will resize the entire model to be pretty close to the actual size of the chair.

W units/scale

3161

Grid Size

4,000000

Figure 35 Use configure units command to resize mesh

Wrapping up in Meshmixer

Hopefully, you’'ve been saving .MIX files throughout the clean-up process. To get the results ready for
Fusion 360, a useable file format will be required.

el

From the file drop down menu select Export or select CTRL+E

In the export mesh dialog, select OBJ in the Save As type drop down menu
Type “Chair.obj” in the File Name field and note the directory

Select Save to create the file.
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Master Modeling and Sculpting techniques in Fusion 360

You've taken photos, generated a mesh model, refined the mesh model for Fusion 360 and now you

ready to utilize this data in Fusion 360. Let’s look at how to bring the reality capture data in Fusion 360 to
start building a model.

Warning: This class is intended for users with an intermediate experience level. This guide will assume
that you have some familiarity with the application.

Insert the Mesh
1. Open Fusion 360

2. From the Model drop down menu, select Create Form. This will activate the Sculpt Environment.
3. Use the Insert Mesh command from the Insert drop down menu

H R H o
x | @ TESTAU v10

CREATE  MODIFY SYMMETRY  SKETCH CONSTRUCT  INSPECT INSERT SELECT  FINISH FORM

=4 @ <SBl 44 S>Fo0r+~ W = & 7
v

« BROWSER el () Decal

v G [ TESTAUv1O [&] Attached Canvas

B Background Canvas

& Insert T-Spline

B Insert Mesh

&3 Insert SVG

Figure 36 Insert Mesh command in Sculpt workspace

4. Browse to and select the Chair.obj file
5. Select Finish Form from the Ribbon

24



Take a picture, it will last longer: Design in Fusion 360 with help from Recap 360

Utilize Sectioned Mesh and Model commands to get started

Create a Section View with the default work plane to slice the geometry in half. Use the “light bulb”

located next to the Section in the Analysis node in the browser to toggle visibility of the section.

1. Select Section Analysis from the Inspect drop down menu

T INSPECT INSERT SELECT
—
lssasan] k
I

== Measzure

|._|§L| Interference

Ay, Curvature Comb Analysis
Zebra Analyzis

D Draft Anahyzis

E Curvature Map Analysis

T Section Analysis J

1 ﬂ Component Color Cyeling Toggle

Figure 37Se|ect Section Analysis from the Inspect menu

2. Select the Light Bulb icon next to the Origin in the model browser to toggle the visibility of the

default work planes
3. Select the YZ plane or the plane that splits the chair in half

4. Select OK

«« BROWSER

a ) [] (unsaved)

b £ Named Views

Q Units: in

0.00 in -

Figure 38 create a section view to make it easier to sketch

@ SECTION ANALY'SIS

Faces b 1selected X

Y Distance  0.00in
XAngle 0.0 deg

ZAngle 0.0 deg

OK

Cancel
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Use the same default YZ plane to sketch out geometry to extrude. The sketch geometry should mimic any
sectioned area of the mesh body.

5. Select Create Sketch from the sketch drop down menu

6. Select the YZ Plane to start sketching on this plane.

7. Select the Line tool from the sketch drop down menu and begin sketching. The 3 point rectangle
is another useful sketch tool you may use to create the sketch below.

Figure 39 Sketch out the profiles of key sectioned parts
Note that I'm not adding dimensions to this sketch. You may choose to do this, or you can choose to add
these later. A good tip is to use the Fix/Unfix command available from the right click menu. This can be
used to quickly “lock down” sketch nodes so that you may drag sketch geometry with more control.

8. Select Stop Sketch from the ribbon when done sketching.

You may re-edit this sketch at any point by right clicking on the sketch in the model browser or in the
timeline and selecting Edit. Double clicking will also work to activate the sketch.
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When satisfied with the sketch, extrude each piece as a separate body. Extrude in one direction as we
will mirror these when we are closer to the end. Use the mesh to judge the Distance of the extrude
command. | found that most profiles could be extruded to about 12 inches and the seat is close to 9
inches.

9. Select the Extrude command from the Create drop down menu.
10. Select the profile you would like to extrude in workspace. You may need to hold down shift and
select multiple profiles at the same time for “overlapping” profiles in some instances.
11. Insure that New Body is select for each extrusion.
12. Type in the Distance or use the arrow glyph in the workspace to drag the extrusion to the desired
Distance.
Warning: After the first extrusion is created, the visibility of the Sketch will be toggled, automatically.
Select the light bulb next to Sketch 1 in the browser to turn the visibility back on.

<« BROWSER
a () () TESTAUv4
b ] Named Views
0 Units: in
> |Q B Origin
4 ) FJ Analysis
@ B Section®
a4 Y B] Bodies
3 & mmGroup0 (2)
o & mmGroupt (2)
@ O Bodys
2 O Bodyto
% O Bodytt
> | B Sketches

Figure 40 Use Extrude command to make new bodies

Use the shell command to “hollow out” the seat body:
13. Select Shell from the Modify drop down menu.
14. Select the Top, Bottom and Inside face of the seat body.
15. In the Inside Thickness field, type 1.875 in.
16. Select OK.

P

S

.

\ \\: = / 2 '@ SHELL
SRS =

’ ‘ Tangent Chain

| Inside Thickne... 1875

Direction I inside

Cancel

Figure 41 Use the Shell to quickly modify the seat body
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© MOVE

Selection Q x
Object ) D ]
Transform

(N

§ XDistance 0.00in

Y Distance  0.00in
ZDistance  0.00in

| XAngle 0.0 deg
~| Y Angle 0.0 deg

Z Angle 0.0 deg

Figure 42 Use the Move command to move the side board into place after extruding

For the side “Apron” of the chair, extrude it from the default plane and then use the move command to
move the body into position. Note that | extruded the Apron to a Distance of .75 inches.

17. To move the Apron from the center of the chair to the outside, select Move from the right click
menu or the Modify drop down menu
18. Select the Apron body.

19. Select the right to drag the body into position (about 11.5 inches along the X direction).
20. Select OK when satisfied.
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Next, we will use the Combine tools and the Delete command to quickly clean-up the seat “stop.”
21. Select the Combine Tool from the Modify drop down menu.
22. Select the Seat rest as the Target Body.
23. Select the Seat as the Tool Bodies.
24. Change the operation to Cut.
25. Check the Keep Tools radio box.
26. Select OK to “subtract” the seat from the seat rest.

>

& .=
b\ T

>

P’ © colbne

| TargetBody [} 1selected X

Operation ﬂ Cut

New Component ()

\ Keep Tools. (%]
1 =

est

Figure43 Use Combine command to subtract the seat from the seat rest

27. Select the two faces in the below image. It may help to toggle the visibility of some bodies in the
browser for this step.

| Press Pull |

p-bRedn]

Sketch W
gT Extrude
Shell
[} Create Selection Set
() Show/Hide
SelectablefUnselectable
Qﬁl Appearance

Figure 44 Select faces for Deletion

28. Right click and select Delete. Fusion will attempt to heal the body.

29



Take a picture, it will last longer: Design in Fusion 360 with help from Recap 360

At the end, you should have 6 new bodies that look something like the below image:

«4 BROWSER e |

a ) [] (unsaved)
b ] Named Views
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(5]
L
L
L
@
L
L

3

ketches

[

1Y
)
O[]0 O 0 0 0 0 0 O

Sketch1

Figure 45 Create 6 bodies — Sanity Check Image
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Use Pipe Command to create tapered legs

lines for legs

#r8YxQ B-E

Figure 46 Create sketch lines for legs

Create a sketch for the legs of the chair on the same section plane.
Select the Pipe command from the Sculpt > Create drop down menu.
Select one of the sketch lines to start the command.

In the section tab, set the global diameter to 1.5 in.

Set the Display Mode to Smooth.

In the End Types tab, leave the End Types as open.

In the Segment tab, move the Density slider all the way to the left to the Fewer setting, all the way
to the left.

No o~ PRE

| @ PIPE

¥

| @ PIPE -
@3 End Types @B Segments 2 Sections @ End Types Im Segments I

¥ Sections ¥ Segments

Path Segment

Density Fewer Maore

3
@
Section @
Global Diameter E 'I

¥ Global Settings

Chain Selection

¥ Global Settings Display Mode TE]
Display Mode (5] Curve Tolerance 0.000 in
Curve Tolerance 0.000 in

—

Display Curve Splits ()

OK Cancel OK Cancel

Figure 47 Parameters in Pipe command
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I & PIPE

@D Sections @ End Types | @D Segments

¥ Segments

Segment

Density Fewer More
Com——

¥ Global Settings

Display Mode B @

Curve Tolerance 0.000 in =
e

Display Curve Splits  [J

1 | OK Cancel
#-E G G-
Figure 48 Before selecting segment node

@3 Sections @3 End Types & Segments

il @ PIPE

¥ Segments

Segment
ISegmems 1 = I
Reset Segment i

¥ Global Settings

Display Mode B 8

Curve Tolerance 0.000 in =

e —

Display Curve Splits [

P . W g @@ OK Cancel
Figure 49 After selecting node and dragglng slider

While on the Segment tab, look closely at the leg preview in the workspace. You'll note a node in the
center of the leg segment. If you select this node, you’ll note that the Density slider will change to a

Segments field that will allow specification of the number of segment for the leg. The node will also
convert to an in-canvas slider.

8. Use the in canvas slider or the Segment field to reduce the number of Segments to 1.
9. Select the Edit Form command.

10. Use the scale command to create a tapered leg.

@ EDIT FORM

T-Spline Ev.. X
Transform ... . 5 B 51
Coordinate... . 1= %=

Selection .. " 7 L ﬁ 53}
» [ Object Snap

: . — » [ Soft Modification

P Selection Options

|Se|ect vertex, edge or face. Alt Key to extrude [Numerical Inputs

‘ OK Cancel
Figure 50 Use Edit Form to scale the leg so that it is tapered
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Figure 51 Use edit form to translate the leg into position

11. Next, use the translate function in the Edit form command to position the leg in place.
12. Repeat these steps for the other leg.

13. When satisfied, select Finish Form to convert the legs into Surface Bodies.

14. From Patch workspace, use the patch tool to “cap” each end of the leg.

Selection _ x

Enable Chaining [

Continuity £ Connected v

Operation (7 New Body v

OK Cancel

Figure 52 Use Patch command to "cap" the ends of the legs

15. Activate the Stitch from the Modify drop down menu.
16. Select the leg and the two patch surfaces.
17. Select OK to generate a solid body.

o EOT
Stitch Surfaces x
Tolerance 3.937E-04 in v

Operation (T New Body S

OK Cancel
=z
@

|

4
-

Figure 53 Use Stitch to create a solid body
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While modeling, you may find that you want to modify some geometry that has been created. Let’s take a
quick look at how you may do this in Fusion 360.

Use Press Pull for fine tuning

Using the Press Pull command from the Model work space > Modify drop down menu, you can fine tune
dimensions, by selecting a face and then dragging them to offset or move faces. This can help you
thicken, thin, or extend geometry.

@ EDom

Offset Type MNew Offset -
0.57%in = Distance 0.579 in -
oK Cancel

\\ .

Figure 54 Use the Press Pull tool to quickly modify geometry.

Utilize the Timeline

Another method for editing the bodies that have been created so far is to go back in time! On the bottom
of the screen, the timeline has been capturing commands as the model is being created. At any point, you
may select a command from the timeline and select edit to roll the model back to the state it was and
make changes. For example, you may go back and edit the originating sketch to make some quick
changes.

l‘* Create Selection Set

(] Edit Sketch

“] Hedefine

[:;]‘ Delete

EI‘E Roll History Marker Here
ACTNITY FEED E Convert to DM Feature

Suppress Features
Rename

A €« » p p aEiI
Find in Window

Figure 55 Edit commands captured in the timeline to fine tune the model

|l
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Utilize Mesh Models to improve designs in Fusion 360

In this section, we are going to review some workflows and tools specific to the Sculpt environment in
Fusion 360 that take advantage of the reality capture data.

Use Pull Command to make the back rest
We will utilize the Pull command to create a contoured, organically shaped back rest.

From Model work space, select Create Form, from the Create drop down menu

Initiate the Sculpt > Create > Plane command.

Create a Plane that is aligned with back rest of the chair on the default work planes.

Use the Sculpt > Modify> Insert Edge command to insert more edges toward the lower back of
the chair.

Use the Edit Form > translate command to drag these control edges down towards the bottom of
the back rest.

e

o

—_—

Figure 56 Create a Plane Sculpt Primitiv-e?)-; the default planes
6. Use the edit form command to move the plane close to the back rest of the chair.

e &ﬁrﬂ"\i
0 0l

© EDIT FORM

T-Spline Entity x

Transform Mode . LS Es
&

Coordinate Space . L
Selection Filter T OO

s

» () Object Snap
» ([J Soft Modification

» Selection Options

» Numerical Inputs
OK Cancel o

Figure 57 Use the Edit Form E:mmand to hwove the primitive closer to the Mesh
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7. Activate the Pull command from the Modify drop down menu.
8. This will toggle the visibility of all the nodes in the Sculpt Plane body.
9. Draw a selection box around these nodes

||+ PULL

| T-Spline Vertices 77 3
Target Select 1B Auto
Pull Type % Surface Points ~

Cancel

10. The Pull command should move the nodes and highlight them. This should snap the Plane body
to the shape of the chair.

Note: The command should automatically select the closest target body by default (the mesh body).
If it does not, you may need to change the target selection type and manually select the mesh body.

11. When satisfied, Select Finish Form, to convert the Sculpt Plane into a B-Rep Surface body in the
Model work space.

« PULL el
T-Spline Vertices x
Target Select 26 Auto v
Pull Type % Surface Points ~

OK Cancel ‘
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<« EDIT FORM

T-Spline Entity

Transform Mode . s B &

Coordinate Space . = L

Selection Filter T T O m
]

» [J Object Snap

» [J Soft Modification

» Selection Options

» Numerical Inputs

i

Figure 60 Clean-up the control edges with the edit form and delete unnecessary edges

The pull command may automatically snap some nodes to an unexpected place, but there’s no reason for
concern. Use Edit form to clean-up the results from the Pull command. Using the scale tools in the edit
form command, you can straighten out edges to be cleanly, vertical.

You can also delete the vertical control edge in the middle of the plane. Double clicking on an edge will
loop select or expand the selection the adjacent edges. Use the delete key on the keyboard to deleting
selected control edges from the sculpt body.

If during the clean-up process the sculpt body becomes offset from the back rest, you may re-use the pull
command to shap the plane back to the body.

Use Thicken Command to finish the back rest

1.
2.
3

Initiate the Thicken command from create drop down menu in the Model work space.
Type .25 in in the Thickness field.
Select OK.

<+« THICKEN © |8

Faces x

Chain Selection @)

Thickness 0.00 in v

Direction 12 One Side -

Operation (T New Body -

Cancel

Figure 61 se the Thicken command to thicken the back rest surface into a solid body
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Use Pull command to make the head rest

In this section, we will create a head rest using a similar procedure to the back rest. This time, the

process will take advantage of the symmetry feature in the Sculpt environment to cover both sides of the
chair.

1. Toggle the visibility of the Section view off the From Model work space, by selecting the light bulb.
The entire mesh should be showing.
2. Select Create Form, from the Create drop down menu (model work space)

« BROWSER L

a [ TESTAU v4
¢ ] MNamed Views

[ Units: in

' 1. Qrigin,

) E1 Analysis
o B Section”

'’ E] Bodies

i E] Sketches

-

=
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Figure 62 Disable the Section in the Browser

3. Initiate the Sculpt > Create > Plane command.

4. Select a default plane to start on.

5. When selecting the center point of the plane body, hover over the origin point and then drag the
cursor towards the head rest. As you move the cursor, you should see a dashed line that infers
the center point is veritical to the origin.

© PLANE

Rectangle Type 1 Center -

Operation (i) New Body -

Figure 63 Use inference to center the back rest
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6. Create a Plane that is aligned with back rest as follows:
a. 4 Length Faces
b. 1 Width Faces
c. Length Symmetry Enabled

© PLANE
Length 20.1811n -
Length Faces 4 v
Width 2268in -
WidthFaces 1w
Symmetry ﬂ} Mirror ¥

Length Symmei...
Width Symmetry
Operation ﬁ New Body v

OK | | Cancel

Figure 64 Create aligned plane for back rest

7. Use the Edit Form > translate command to drag these control edges down towards the head rest.

© EDIT FORM

T-Spline Entity X

Transform Mode . LE.— E:s a

Coordinate Space . 2 %

Selection Fiter S M
3

» (O object Snap

» {J Ssoft Modification

P Selection Options

P Numerical Inputs

OK | | Cancel |

Figure 65 Use Edit Form to translate the plane closer to the mesh

8. Activate the Pull command from the Modify drop down menu. The control vertices will appear in
the workspace.

© PULL
T-Spline Vertices
Target Select 3B Auto v
Pull Type s surface Points v

| | Cancel |

Figure 66 Activate the Pull Command
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9. Drag a selection box around these control vertices to select them. The vertices should

automatically “snap” to the mesh body.

@ PULL

T-Spline Vertices x

Target Select *ff Auto
Pull Type s Surface Points

v

v

OK | | cancel

Figure 67 After selecting the control vertices, they will automatically snap to the mesh body

10. Activate the Edit Form command and “clean-up” the sculpt body.

© EDIT FORM

T-Spline Entity X

Transform Mode . & E:.s m

Coordinate Space . 12 %

Selection Fitter SRR
S

» () Object Snap
» (J Soft Modification

P Selection Options

» Numerical Inputs

0K Cancel

Figure 68 Use Edit Form to clean-up the "pulled" sculpt body

11. Next, select the Thicken command from the Sculpt > Modify drop down menu

© THICKEN
T-Spline Body X
Thickness 0.00in -
Thicken Type &) Sharp v
Direction 5). Normal -
OK | | Cancel

Figure 69 Use the Sculpt Thicken command to thicken the head rest .

12. Select Finish Form to convert the Sculpt Body into a B-Rep solid Body.
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Create the Arm Rests using Sculpt Commands

In this section we are going to use some more advanced Sculpting techniques to create the arm rest of
the chair.

1. Select Create Form, from the Create drop down menu (model work space)
2. Create a 2 x 3 Plane that is lined up with the arm rest

© PLANE
Length -5.5281in v
Length Faces 2 iy
Width 379460 v
Width Faces 3 e
Symmetry 1% none -
Operation (i) New Body -
OK | Cancel

Figure 70 Create Sculpt Plane

3. Use the Edit Form Command to shape the Plane into the something that gets close to the
bottom surface of the arm.

Let’s look at quick tip for the Edit Form tool.
4. With the Edit Form command active, double click on a control edge to loop select the edges.
5. Select the Reorient button (steps 4-8).

— — R - - E
© EDTFORM:
T-Spline Entity
Transform Mode . &: ] Ea
C Space . 1= 2?
......... Selettion Filter L T CE
i
2] Object Sna
0.60.in I L& I S
@ » [ soft Modification
. k.5 ian. Options
» 'Irpuf
K Cdnce
—

Figure 71 Reorient the Edit Form Triad
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7. Select the check mark icon Stop Reorient.

8. Now continue to use the triad in its new location to manipulate the Sculpt body.

@ EDITFORM

5

» [ Object Snap
» [J Soft Modification

b Selection Options

P Numerical Inputs

T-Spline Entity x
Transform Mode . % E:j E
Coordinats Space . [
Selection Fitter T O

OK

Cancel

© EDIT FORM

&

» (O object Snap
» (3 soft Modification

» Selection Options

» Numerical Inputs

T-Spline Entity
Transform Mode . % E:: m
Coordinate Space . ]_;" %
Selection Fiter o T Gy ﬂ

000in v -
Stop Reorient

© EDITFORM

T-Spline Entity x

Transform Mode . \& E:.: m

Coordinate Space . [

Selection Fiter T TE O
T

» [J Object Snap

» [ soft Modification

P Selection Options

» Humerical Inputs

Cancel

Figure 73 Using the Reorient command it is easy to create the shape of the arm rest

9.

© EDITFORM

T-Spiine Entity x
Transform Mode . & E!} m
Coordinate Space . 2%
Selection Fiter S W I T

)

» () object Snap
» (J Soft Modification

» Selection Options

IP Numerical Inputs
0K

| Cancel |

Figure 74 Continue Editing the Form until it follows the lower curvature of the arm.

Use the Edit Form command until the shape begins to follow the contour of the arm rest.

10. Once close to the figure above, we will begin to add material to the sculpt body.
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11. With the Edit Form command still active, hold down the Alt (Option key on Mac keyboard) and

then select and drag the triad Translation manipulator. This should “add” material to the Sculpt

body.

12. Using a combination of the Edit Form tools and the ALT + Edit Form Translation, continue to
manipulate the surface until the Sculpt body almost wraps around the chair.

13. Don'’t forget to use the Re-orient trick!

\ | -
© EDITFORM

T-Spine Enty x

Transform Mode . it & &

coordnate space [ 19 &

Selection Fiter T 75 B
)

© EDITFORM

vomecy S
T e i B

» (J Object Snap

» O Object Snap

» ([ soft Modification

» O soft Modification

P Selection Options P Selection Options

» Numerical Inputs \@ll> Numerical Inputs

OK Cancel

Figure 75Hold down ALT while using the Edit Form command to add material to the Sculpt‘ Body

14. When satisfied, select OK to close the Edit Form dialog

Use Weld Vertices to “Close” the Sculpt body.
1. Select Weld Vertices from the Modify drop down menu.
2. Select the Node to move, first.
3. Next, select the Node to be welded to.
4. Select OK.

B\ o welpvermces

Tpinevertos

§O Vertex to Verte.. .

Maintain Crease Edr.. ()

OK

Cancel

Figure 76 Use the Weld Vertices command to weld together the open “seam” in the Sculpt Body

5. After the first weld is completed, the sculpt body will go into “box” mode. Just ignore this until all

the vertices are welded together.
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6. Continue to Use the Weld vertices command to weld together the other control vertices until the
sculpt body resembles the image on the lower right.

]

© WELD VERTICES

Figure 77 Continue use the weld Vertices command. The results should be a smooth surface.

Use the Fill Hole Command to cap the ends of the arm rest
In this section, we will close the remaining holes in the arm rest with the Fill Hole Command

1. Select the Fill Hole command from the Modify drop down menu.
2. Select one of the Bold open edges of the Sculpt Body.
3. Use the Reduced Star in the Fill Hole Mode drop down menu.

© FILLHOLE
Fill Hole Mode (D Reduced Starv

Maintain Crease Edges (L)

Cancel

Figure 78 Use the Fill Hold Command to close the open holes in the Sculpt Body

4. Select OK when the preview shows the hole being filled.
5. Repeat steps 1-4 for the other open hole.
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Fine Tune the Sculpt Body to complete the arm rest
At this point, you may find that the resulting Sculpt Body is needs some fine tuning.

1. Activate the Pull Command from the Modify Drop down menu.
2. Drag a Selection box around the nodes on the two inner control edges.
3. The nodes should snap to the arm rest body.
4. Select OK.
'@ PULL Y

T-Spline Vertices x

Target Select <[ Auto v

Pull Type e Surface Points v

Cancel

Figure 79 Use the Pull command to help fine tune the control vertices

5. In the following steps, we will use the Edit Form command to fine tune the shape of the arm rest.
6. Activate the Edit Form command from the Modify drop down menu (or the right click menu

|@ EDTFORM ‘
T-Spline Entity x
Transform Mode . lé% E:*" @
Coordinate Space . Ll;’ "b
Selection Fitter “I} i LT}
3

» () Object Snap

| » [ Soft Modification

|» Selection Options

,> Numerical Inputs

OK Cancel "

'Figure 80 Use Edit Form to continue tweaking the model.
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In order to convert the Sculpt Body to a B-Rep solid body, it is critical that the T-spline body does not
contain overlapping or self-intercepting geometry.

I° EDIT FORM
| T-Spline Entity x
Transform Mode . I& E:.s E
Coordinate Space . 1< 'j'g
Selection Filter s § ﬁ
5

» () Object Snap
» ([J soft Modification

|» Selection Options

| Humerical Inputs

OK Cancel

‘ EEE |~ L
Figure 81 Toggle Box Display by selecting the Sculpt Body and pressing ALT + 1 (Option + 1 on Mac)

7. Toggle Box Mode for the Sculpt Body:
a. Select the Sculpt body.
b. Toggle Box Mode:
i. Press ALT + 1 (Option + 1)
ii. Select Display Mode from Sculpt > Modify drop down > Performance fly-out
8. Continue using the Edit Form command in the mode to “clean-up” the sculpt body.
9. Ensure that there are no overlapping or self-intercepting faces/geometry.

46



Take a picture, it will last longer: Design in Fusion 360 with help from Recap 360

Another display mode that can be useful is the Control Frame Display. This mode will display both the
Smooth body and the control frame at the same time.

© EDIT FORM

T-Spiine Entity ' x

Transform Mode . & E:s m

Coordinate Space . 1< %

Selection Fiter S ST R m
5

» () Object Snap
» ([ Soft Modification

» Selection Options

Y

» Numerical Inputs

OK Cancel 4
Figure 82 Toggle Control Frame Display by selecting the Sculpt Body and pressing ALT + 1 (Option + 1 on Mac)

10. Toggle Control Frame Display for the Sculpt Body:
a. Select the Sculpt body.
b. Toggle Box Mode:

i. Press ALT + 1 (Option + 1).

ii. Select Display Mode from Sculpt > Modify drop down > Performance fly-out.
Continue using the Edit Form command in the mode to “clean-up” the sculpt body.
Ensure that there are no overlapping or self-intercepting faces/geometry.
Using the Control Frame display, you can insure fidelity in the sculpt body and that the smooth
sculpt body matches the desired shape.

When satisfied with the shape of the arm rest, select Finish Form in the top ribbon to convert the
Sculpt body to a B-Rep solid body.

11.
12.
13.

14.

ACTVITY FEED L

FrE O a D@
e py @EINIANTN GG HEB@ULUULUEBEIS@ /00 @

Figure 83 Image Provided for Sanity Check
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Final Leg Clean-up

1. Select the Combine command from the Modify drop down menu in the Model work space.
Select one of the legs for the Target Body.

Select the Arm Rest for the Tool Bodies.

Select Cut in the Operation drop down menu.

Check the Keep Tools radio box.

Select Okay.

ogAwWN

@ EDM

Tool Bodies [ 1selected %
Operation E Cut -

New Component

I Keep Tools @
— )

OK Cancel

Figure 84 Use the Combine Command to Cut the legs down

7. Select Okay to cut the leg and split it into two bodies.
8. Repeat steps 1-7 for the other leg.
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Right click on the top of the leg in the workspace and select Find in Browser to highlight the
Bodies in the browser.

Do this for each leg and note which bodies they are in the browser.

Use Shift + select to highlight these bodies in the Model Browser.

Right click and select Delete to delete these bodies from the workspace.

‘Y & mmGroupl
mmGroup1
Bady15 (1)
Body17
Body16
Body1
Body14
Body8
Body13
Body2

CellelCelCo el oo e e e el ol ol e ")
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Eii

B Aiign
b} F] Sketches

+5+ Move

%,_ Create Components from Bodies
ﬁ Create Selection Set

G Delete

@ ShowMHide
Selectable/Unselectable

Physical Material

& Appearance

<[] Texture Map Controls
Properties

Copy

ACTWITY FEED cut +r5 Qo O E
Figure 85 Delete the unwanted bodies from the design

Select Create Sketch from the Sketch Drop down menu.
Select the YZ plane and sketch a horizontal line where the “Floor” should be.
Select Finish Sketch when satisfied

W mmGroup0
Q@ & mmGroup1
Q ) Boay1s(n)
R (O soay17
2 () Bodyts
@ O soay
@ ([ Bodyts
9 O sone
2 () Body13
9 O sone
2 O soae
@ (J Boays
@ (J 8oays
9 O soazs
b ) FJ Sketches

Figure 86 Sketch a line to represent the floor
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Initiate the Split Body command from the Modify drop down menu of the Model workspace.
In the Body to Split, select both legs in the work space.

For the Splitting Tool, select the sketch line.

Leave the Extend Splitting Tool radio box checked.

Select OK.

|« BROWSER °

a () AuTEST2v1
> ] Named Views
[ Unis:in

> QB3] origin

> B Analysis

4 Q. Bodes,
@ & mmGroupo
@ & mmGroupt
Q () Body1s(1)
@ [0 Bogy17
@ [ Bodyte

Body to Spit [} 2selected X

s x

Extend Spitting Tool

ok | | Cancel |

> L), Skeiches,

Figure 87 Use the Split Body command to split the legs
Repeat Steps 9-12 for the lower ends of the legs and delete them from the design.

4 | K .Bedis,
Y & mmGroupd
Y & mmGroupt
Q[ Bogy1s ()
G O Boayr7
G [ Bosyts
@ O Bouyt
[T
G [ Boays
o [T
G [ Boay2
G [ Boays
@ O Boays

o ezl

- o] (@]
Q[ Boayar [(sketen v |
QOW UEAIign

b [ P Sketches B, Create Components from Bodies
[E] Create Selection Set

Figure 88 Delete the unwanted split bodies from the design

Use the Press Pull command to close any remaining gaps in the model. Refer back to page 34 for
finer detail.
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1. Activate the Mirror command from the Create drop down menu.
2. Inthe Pattern Type area select Bodies. Please note that this will toggle the selection filter, so
don’t miss this step!
3. Drag a selection box around the bodies that need to be mirrored. See the below image for
reference.
‘-ﬂ BROWSER 2| @ MWIRROR
a (] AutEsT2v2 Objects [ 10 selected X

F] MNamed Views
‘E__‘j. Units: in

@ L, origin,
@ B3] Analysis

Q @ mmGroupd
@ ) Bodyts (1)

G () Bodyi7

v [CEssEE
w s
v [CessE
 [CTEsEEl
v CessEn
v s
@ [CNesss)
v s
@ [CNesssEy
e

iy B Sketches

Mirror Plane x
Pattern Type ] D @

OK Cancel

Figure 89 Use the Mirror command to mirror the bodies

4. When this command is completed you should have something that resembles a chair.
5. Don't forget to Save the Design!
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Figure 90 Sanity Check Image

52



Take a picture, it will last longer: Design in Fusion 360 with help from Recap 360

Create quality visualizations of designs in Fusion 360

In the next section we will complete the workflow by turning our model back into an image utilizing the

Render work space in Fusion 360.

Reset the Orientation of the Model

1. Select the Bottom view in the ViewCube on the Upper Right-Hand side of the Fusion 360 window.
2. Use the rotation arrows to position the chair in the desired orientation.

3. When satisfied, right click on the View Cube.

4. Select Front from the Set Current View As fly out menu.

Front
Top

b @ a4
Go Home

+" Orthographic
Perspective
Perspective with Ortho Faces

Set current view as Home
Reset Home

Set current view as 2
Re=set Front

Figure 91 Re-Orient the Workspace with the View Cube

Change the Appearance of the Bodies

1. Drag a Selection box around all of the bodies in the workspace to select them.

2. Right click and then select Appearance.

[l Repeat Mirror

@H_ Create Components from Bodies
[Ef Create Selection Set

{7 Showi/Hide
SelectablefUnselectable

i3l laterial

@. Appearance
' = Ule d
Properties.

Copy
Cut

Figure 92 Select all Bodies and initiate the Appearance command
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3.

In the Appearance dialog, insure that the Apply To: field is set to Bodies/Components.
4,

In the Library, browse to Wood > Finished > Walnut Semigloss.
5. Select and drag the Walnut Semigloss onto the selected bodies in the workspace.

© APPEARANCE

¥ Apply To:
Bodies/Components (@)
Faces O

¥ In This Design
- - —~ -
) )
‘d
- ~
-
= -

¥ Library
Library Fusion 360 Appearance Library v
| 4]
( " Oak - Semigloss
Pine - Glossy

Pine - Semigloss

Walnut - Glossy ¥

—
¥
—J

Close

Figure 93 Apply Walnut Semigloss to all Bodies

6. The appearance of the bodies should update to match the Walnut Semigloss.
7. Select Close in the Appearance dialog.
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Create Brass foot details
1. Select Create Sketch from the Sketch Drop down menu.

2. Select the YZ plane and sketch a horizontal line about an inch above where the floor should be.
3. Select Finish Sketch when satisfied.

© N gk

Figure 94 Create a Sketch line just above the "floor"

Initiate the Split Face command from the Modify drop down menu of the Model workspace.
In the Face to Split, select both the round face of all 4 legs in the work space.

For the Splitting Tool, select the sketch line.

Leave the Extend Splitting Tool radio box checked.

Select OK.

@ EDT

Faces to Split X

Splitting Tool [ 1selected X

Extend Spliting Tool @)

OK Cancel

Figure 95 Use Split Face command to split round faces of legs
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9. Right click and select Appearance to activate the command.

10. In the Appearance dialog, insure that the Apply To: field is set to Faces.

11. In the Library, browse to Metal > Brass > Brass Polished.

12. Select and drag the Walnut Brass Polished onto the split faces on the lower legs.

Figure 96 Apply Brass - Polished appearance to the four leg tip faces

Create Rendering in Render Work Space

1. Look for the Effects fly out menu in the Navigation bar.
2. Enable all of the options in the Effects fly-out menu, checking each one.

Effects > Envirenment Dome
Obiject Visibility p| ] Ground Plane
7] Ground Shadow
Camera P‘ Ground Shado
Ground Reflection
Ground Plane Offzet Object Shadow
Enter Full Screen  Ctrl+Shift+F Ambient Occlusion
m Anti-Aliasing
-5 & o Bl@

Figure 97 Enable all Effects
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3. Toggle to the Render Workspace from the ribbon.

CREATE
Mo @ €

« MODEL &

|
LT || ] AuTEST2v
I»

=] Mamed Views:
PATCH

] Units: in
] Origin
renper |0 Analysis
] Bodies

= 10 & mme

Figure 98 Change to the Render Workspace

4. Select the Environment command from the Setup panel of the ribbon.
5. Inthe Environment dialog, make the following changes.

Set the Style drop down to Soft Light.

Set the Rotation to -7.

Select Custom Color and select bright white.

Enable the Ground Shadow.

Enable the Ground Reflection.

Poo o

@ ENVIRONMENT

¥ Environment

Style Soft Light A
Exposure [-3, 3] 0.000
Rotation [-180, 180] -7

¥ Background Color

From Environment ()

Custom Color @
¥ Eifects
Ground Shadow @

Ground Reflection &)

Close

Figure 99 Modify the Environment setting to your liking
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6. Select Close in the Environment dialog.
7. Select the Ray Tracing Command from the Ray Tracing drop down menu.
8. Change the Quality to Advance and wait.

Note: Each Iteration that passes will produce a higher and higher quality image. The longer you wait, the
better quality the image will be. One note is that at a certain point, the return (image quality) on your
investment (time/lterations) is reduced. Simply, give the image a few minutes to render. The Ray Tracing
will never stop on its own accord.

© RAY TRACING

@ Settings

Quality Advanced v
Elapsed time: 543 sec

iterations: 706

Image refinement will continue until interrupted.

Pause Disable

Figure 100 Be patient as the Ray Tracing make iterations of the render
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9. When satisfied, select the Capture Image command from the Render drop down menu to save an
image.

Image Opticns - Iﬁ

Image Resolution
[Current Document Window Size b
‘ Width  |s00 Pixels W: 1680
Height | 425 Pixels H: 894
Resolution |72 Pixels/Inch

Lock Aspect Ratio

Transparent Background

Enable Anti-aliasing

Figure 101 Use Capture Image Command to save an image of the render

10. You may now save and close the workspace, you are finished!

59



! pj!{‘ AUTODESK UNIVERSITY 2014

60



! r.njl{__ AUTODESK UNIVERSITY 2014

References
http://en.wikipedia.org/wiki/Parallax

http://www.tested.com/tech/photography/459735-living-photography-what-heck-f-stop/

https://adsk-recap-public.s3.amazonaws.com/Getting Started Guide ReCap Photo.pdf

https://www.youtube.com/watch?v=SDfjYI2Wz4k

YouTube Video of Manual Stitch Process in Recap 360:

https://www.youtube.com/watch?v=SDfjY12Wz4k

Special Thanks

A Special Thanks to The Good Mod in Portland, OR for allowing me to invade their space and snap some
photos of their beautiful furniture.

www.thegoodmod.com

About The Good Mod

The Good Mod is a furniture and design house created by Spencer Staley in 2006. In addition to being a
furniture store, The Good Mod is a multi-faceted design studio offering services including design/build,
upholstery, and expert furniture restoration, to name a few. All of these things make The Good Mod a
one-stop shop for the place that you want to make extraordinary.

Visit The Good Mod's showroom and design workshop in downtown Portland at 1313 W Burnside St.,
Portland Oregon, 97209 on the fourth floor.
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